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Manual for Analytics Software of Testing Pile by Reflected Wave 

Conventions in this manual 

1. Word with gray background and black box is a button on the 
interface, e.g. OK. 

2. The keys on the instrument panel are represented by 【】，e.g.
【SAVE】. 
3. Word with white background and black box represent software 
menu command in Windows, and “→”is a separator between different 
menu levels. e.g. File→Open means the command of selecting 
“Open” under the “File” menu. 
4. Word with gray background but without box indicates the name 
of the control (choice box, input box, etc.) of the popup window on 
the screen, such as the input box of File Name in the open-file 
window. 
5. The sign  means special attention is needed here. 
6. Besides the descriptions in the manual, some prompt messages 
may show automatically in the use of the software. Please operate 
accordingly. 
7. The bitmap file in the operation manual is a graphics file with an 
extend name as BMP file. 
8. Interface of this software comprises of multiple parts or views. A 
certain part will become the focus after it is clicked. 
9. Window pictures for illustration in this manual are offered by the 
WindowXP system. Window style or name of this software will be 
slightly different when installed in other systems. 
10. The software interfaces and photos in manual are only for 
reference. There will be changes with software upgrade and 
improvement of products. No further notice is provided.  
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Chapter 1 Brief Introduction 

Analytics Software of Testing Pile by Reflected Wave is a kind of 
application software launched by Beijing ZBL Science＆Technology 
Co., Ltd. It is mainly used for analytical processing of the data of 
foundation pile integrity assessed by ZBL-P810 foundation pile 
dynamic tester. 

This software is user-friendly in interface and easy in operation, 
whose operational approach and interface forms completely 
correspond with the style of Windows. Users familiar with the 
operation of Windows application software will find it easy to use this 
software. This software is designed specifically for people engaged in 
engineering detection. It can work on computers installed with 
operating system of Windows95, Windows98, WinMe, WindowsXP, 
Windows2000 or Windows NT. 
 
The main functions of this software: 

1) Managing the engineering information, pile information and 
multiple waveform data, etc of foundation pile detection in 
engineering; 

2) Acquiring statistical information(minimum wave velocity, 
maximum wave velocity, average wave velocity; pile 
amount of , , , ⅣⅡ Ⅲ Ⅳ, etc) of the detected foundation pile; 
generating a summary table in Excel; 

3) Smoothing, integrating, filtering and exponential or linear 
magnifying, etc the detecting waveform, useful information 
in the waveform being highlighted;  Analyzing the 
amplitude spectrum or power spectrum in the waveform and 
making aided analysis for foundation pile integrity; 

4) Scaling, stretching, compressing, shifting and rotating, etc 
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the waveform conveniently; 
5) Setting the position of pile head, pile toe and defect easily 

and saving the result. 
6) Regaining original waveform at any time and reprocessing 

analytical process if the result is not satisfactory; 
7) Saving the waveform, spectrogram and pile schematic of 

foundation pile detection in the form of bitmap, so that other 
graphics software can process them; 

8) Print preview and printout of results. 
This software involves five different kinds of files, which are 

shown in table 1.1. 
table 1.1 List of file type 

Type Extension Illustration 
Project File ZPJ Engineering Data File 
Data File ZIT Single Waveform Data File 
Graphic File BMP Bitmap File 
Text File TXT ASCII File 
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Chapter 2 Installation ＆ Running ＆

Uninstallation 

 
Installation of this software is similar to that of common 

Windows software. Installation of this software and the preparation 
work before usage will be specifically introduced in this chapter. 

Files needed for the installation of this software are stored in the 
attached U-disk along with the instrument. 
 

2.1 Installation 

1. Insert the U-disk into the computer, find the file of 
P8Setup.exe under the root directory in the U-disk and run it. The 
installation wizard will uncompress the needed files into computer 
(Figure 2.1). Once uncompress is completed, the installation wizard 
(Figure 2.2) will be started automatically to instruct the users how to 
make installation. After several minutes, a welcome screen like Figure 
2.3 will appear.  
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Figure 2.1 Uncompress Interface 

 
Figure 2.2 Start the Installation Wizard Interface 
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Figure 2.3 Welcome Screen 

2. To quit Setup please click Cancel on the welcome screen. By 
clicking the Next button, users can see the User Information dialog 
box in Figure 2.4; 

3. After entering the user’s information in the dialog box in 
Figure 2.4, if click the Back button you will return to the interface in 
Figure 2.3; If you click the Cancel button you will quit Setup; Click 
the Next button you will see a pop-up Select Installation Folder dialog 
box (Figure 2.5) 
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Figure 2.4 User Information Dialog Box  

 
Figure 2.5 Select Installation Folder   
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4. After selecting a target folder by clicking Browse button on 
the window in Figure 2.5, if click the Back button you will return to 
the interface in Figure 2.4; If click the Cancel button you will quit 
Setup; If click the Next Button you will see a pop-up Information 
Browse interface (Figure 2.6). 

5. In the dialog box in Figure 2.6, if click the Back button you 
will return to the interface in Figure 2.5; If click the Cancel button 
you will quit Setup; If click the Next button you will begin to copy the 
files, and it will pop up an Installation Progress dialog box (Figure 
2.7). The consumed time is related to the hardware configuration of 
computer, ranging from a few seconds to a few minutes. You can quit 
Setup at any time during the process by clicking the Cancel button. 

 
Figure 2.6 Information Browse Dialog Box  
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Figure 2.7 Installation Progress 

6. Once the files are copied completely, you will see a pop-up 
Install Completion dialog box (Figure 2.8). Click the Finish button 
you will end the installation. After that a shortcut icon to invoke this 
software will appear on the desktop and program package. Select the 
option of “now restart computer” if there is one, then the system will 
restart automatically and finish the installation. 
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Figure 2.8 Install Completion   

NOTE: Please close all the application software, such as 
antivirus program or firewall, etc before installation, otherwise 
some problems may appear. 
 

2.2 Running 

Once the installation is completed, you can run this software by 
selecting the following with mouse: Startup→ All Programs→Beijing 
ZBL→ Analytics Software of Testing Pile by Reflected 
Wave→Analytics Software of Testing Pile by Reflected Wave. 
Besides, you can also run it by double clicking the shortcut icon 
Analytics Software of Testing Pile by Reflected Wave on desktop. 
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2.3 Uninstallation 

Once this software is updated, if the upgrade is needed, you 
should uninstall the software of old version. There are two methods 
for uninstallation: 

Method 1: Similar to other application program in Windows, you 
can double click the “Add/Remove Programs” icon in “Control Panel”, 
select the software to be uninstalled (Analytics Software of Testing 
Pile by Reflected Wave) in the pop-up dialog box and then click the 
Add/Remove button to start Uninstall Wizard. The remaining steps 
can be found in method 2. 

 
Figure 2.9 Start Uninstall Wizard 

Method 2: The Uninstall Wizard can be started by selecting the 
following options: Startup→ All Programs→Beijing ZBL→ Analytics 
Software of Testing Pile by Reflected Wave→ Uninstall Analytics 
Software of Testing Pile by Reflected Wave. Later the Installation 
Options dialog box in Figure 2.10 will appear.  
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Figure 2.10 Installation Options Dialog box 

Selecting the third option Remove in the Installation Options 
dialog box, if choose Cancel button you will end the uninstallation; If 
choose Next button you will start the process of automatic 
uninstallation, followed by the Uninstallation Progress dialog box 
(Figure 2.11). When the uninstallation is finished, the Uninstallation 
Completion dialog box (Figure 2.12) will pop up. Click the Finish 
button and this software will be uninstalled completely. 

NOTE: Installation Options dialog box will pop up 
when you want to reinstall this analysis software if this software 
has already been installed. On this condition, you should select 
the first or the second option——Modify or Repair. By clicking 
the Next button, the upgrade of this software will be completed. 
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Figure 2.11 Uninstallation Progress Dialog Box  

 
Figure 2.12 Uninstallation Completion Dialog Box 



Manual for Analytics Software of Testing Pile by Reflected Wave 

 

Chapter 3 Analytics Software of Testing 
Pile by Reflected Wave 

 
Before using Analytics Software of Testing Pile by Reflected 

Wave to analyze the signal of testing foundation pile, you should store 
the detected data file into computer having been installed with this 
analysis software. As for P8 series of foundation pile dynamic testers, 
first the newly detested data should be copied into U disk, and then 
data in the U disk shall be copied into a certain folder of this computer; 
as for P800 foundation pile dynamic tester, because the data is stored 
directly in the laptop computer liked with apparatus, it can be 
transferred into computer installed with this analysis software for 
further analysis. 
 

3.1 Introduction to Software Interface 

The interface of this software is composed of seven parts (Figure 
3.1.1): Title Bar, Menu Bar, Tool Bar, Status Bar, Pile Information 
Area, Pile List Area, Wave Diagram Area and Pile Diagram Area. 
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Figure 3.1.1 Software Main Interface 

 
1. Title Bar displays from left to right the following: Software Icons, 

Current Pile File Name, Software Brand and three standard 

application buttons in Windows . The functions of these 
three buttons are minimum, maximum/restoration and closure of 
program. 

2. Menu Bar comprises of seven drop-down menus: File, Edit, View, 
Settings, Process and Help. By clicking any menu item, you will see 
one drop-down menu accordingly, corresponding a set of function 
respectively. Submenu items of the seven menu items include all 
the functions of this software. When some menus are grayed out, 
their functions are invalid at current state. 

3. Tool Bar is composed of a series of buttons (Figure 3.1.2), every 
button represents one common function. Although these commands 
are already included in the menu commands, it is much more 
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convenient for users to invoke these common commands through 
toolbar buttons. The cursor hovering over a certain button for a 
moment, the function tip of this button will appear on screen 
automatically. When the button is grayed out, it means its function 
is invalid at current state. 

 
Figure 3.1.2 Tool Bar 

4. Status Bar is mainly for displaying short helping information and 
related data. 
5. Pile Information Area displays the current basic information and the 

process parameters of the chosen pile (Figure 3.1.3). Users can set 
and modify the process parameters. After modification, if users 
press the   button, the process parameters will be processed 
according to the setting. By pressing the Default button, users set 
the process parameters as the recent one; by pressing the Para. 
Recovery button, users set the process parameters value as the 
default one.  

 
Figure 3.1.3 Pile Information Area 

6. Pile List Area is used for displaying all the piles and their validity 
of current project. It is located at the left half of the main interface 
(Figure 3.1.4). Users can open a certain pile file by double clicking 
it for the analytical processing. Also users can open a pile file by 
doing the following steps: selecting a pile file by ↑ and ↓button; 
then pressing the  button. 

By clicking the left mouse button on Pile Files or the title bar of 
Validity (Figure 3.1.4.a), users can sort all the pile files in ascending 
or descending order. By clicking the left mouse button on the title bar 
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of No. (Figure 3.1.4 b), users can set all the pile files into state of 
validity or invalidity. 

By clicking the left mouse button on the check box in front of 
sequence number, users can select or unselect the corresponding pile 
files, setting the validity of the pile file; also after selecting multiple 
pile files, users can modify the validity of all the chosen pile files by 
using “File” menu, “Validity Modification” in the right-mouse menu 
or pressing Space key. 

The pile files can be sorted by dragging and dropping the left 
mouse button. Specific steps are as follows: after selecting one or 
more pile files (Figure 3.1.4c), users can click the pile files with left 
mouse button while keep holding down the mouse; drag the selected 
object on top of one pile files (Figure 3.1.4d) and then loose the left 
mouse button. Thus, the selected pile files are shifted behind the 
original one, rearranging the pile files.  

In addition, users can modify the name of a pile file in the Pile 
List Area: first click the row of the pile file to be modified with the 
left mouse button; then click the name of the pile file one more time to 
make an edit box appear (Figure 3.1.4e); at last input the file name 
and press   key or click anywhere to finish the modification. 
 

 
a) Automatic Sorting 
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       b) Validity or Invalidity Setting of All Pile Files 

 
c) Selection of Files 

 
 d) Drag and Drop 

 
e) Rename Pile File 

Figure 3.1.4 Pile List Area 
The methods of selecting multiple pile files in the Pile List Area: 
1) To select the target pile files, click the left mouse button 

while holding down the Ctrl button; 
2) To select all the pile files between two pile files, click the 

left mouse button respectively while holding down the Shift 
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button; 
3) To select multiple pile files, select pile file one by one by ↑ 

and ↓ key while holding down Shift key. 
7. Wave Diagram Area, displaying the current pile oscillogram, is 

located at the right part of the main interface, as shown in Figure 
3.1.1. 

The Waveform Area will display all the detected waveform in the 
current pile successfully. When there are many waveforms which can 
not be fully displayed in one screen, there will be a scroll bar at the 
right of the Waveform Area for examining. All the waveforms will be 
magnified in one time by double clicking the left mouse at any 
waveform. Also, all the waveforms can be restored by double clicking 
the left mouse. 

The black dotted line in the middle of every waveform is the 
basic line. The underneath is scales whose scale value can be either 
time or length. The two vertical red dotted lines in every waveform 
represent the place of pile head and pile toe; the green vertical dotted 
line is the defected place set by the users, and there is the defected 
place under the dotted line. On the top left corner, there is a sign of 
“n/m”，in which the numerator “n” represents the place of the current 
channel waveform among the whole waveforms in the pile files. The 
denominator “m” represents the total number of waveform in the 
current pile files. If the number is red, this waveform is the current 
waveform; otherwise, it will be in blue. 

In the Waveform Area, users can set this channel as the current 
channel by clicking the left mouse on a certain waveform, followed by 
the displaying of phonation time T of mouse position (relative to the 
starting point of waveform), jet lag DT (relative to the pile head), 
length L, wave velocity C and range of waveform Y in the status bar. 
By holding down the left mouse and dragging the cursor, users can 
check the above parameter of cursor position. Besides, removing 
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cursor by pressing ←and →buttons, users can check the parameter 
value. Keeping down the ←and →buttons, users can also move the 
cursor rapidly. 

When the current focus is at the Waveform View, users can make 
shift among channels by ↑ and↓ keys. For example, when the channel 
is moved to the last one, users can move the channel to the first by 
pressing ↓ key; when the way is moved to the first one, users can 
move the channel to the last one by pressing ↑ key. Also users can 
page down and page up by pressing the keys of Page Up and Page 
Down; by pressing the Home key users can move the channel to the 
first one; by pressing the End key users can move the channel to the 
last one. 
 By clicking the right mouse button on the Waveform Area, users 
will see a pop-up menu shown in Figure 3.1.5. Its function is exactly 
the same as the one of corresponding menu in menu bar. Besides, this 
menu will also pop up by pressing   button in the Waveform Area.  

  

Figure 3.1.5 Pop-Up Menu 
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If the analysis of amplitude spectrum or auto-power spectrum of 
all the current waveforms in current piles is implemented, the 
amplitude spectrum diagram or auto-power spectrum diagram will be 
displayed in the Waveform Area, shown in Figure 3.1.6. In every 
spectrum diagram, the red dotted line represents a peak frequency; the 
upper right shows the related frequency data with this spectrum 
diagram in blue (dominant frequency Fm, frequency resolution F0, 
respective peak frequency and frequency difference); the underneath 
is frequency scale value. 

When the Waveform Area displays the spectrum diagram, the 
operation of switchover of channels, patterns and cursors will be the 
same as the displaying of time domain of waveform. When the cursor 
is shifting, the position of cursor is showed as F frequency in the 
status bar. 

 
Figure 3.1.6 Amplitude Spectrum Diagram 

 
Figure 3.1.7 Pop-Up Menu in the Spectrum Area 

    When the Waveform Area displays the spectrum diagram, users 
will see a pop-up menu shown in Figure 3.1.7 in the Spectrum Area 
by clicking the right mouse button, whose function is exactly the same 
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as the corresponding menus in the menu bar.  
8. Pile Diagram Area, displaying the current pile schematic, is located 

below the last waveform diagram of the Wave Diagram Area. This 
area shows the pile after analysis and schematic of the defects. 
Without analysis, this region is empty. When the Wave Diagram 
Area displays the spectrogram, the Pile Diagram Area is empty 

 

3.2 Menu commands  

3.2.1 File Menu 

1. New Project 
The creation of a new project data file (extension ZPJ) is mainly 

used to manage the project information and a summary of all the 
foundation piles. 

After selecting New Project menu, there will pop-up dialog box 
of “Project Information” showed in figure 3.2.1 to set the information 
related to new project in which the Project Name can not be empty. 
After setting the project information, if users select the ZBL-P810 Pile 
Dynamic Tester and click OK button, there will pop-up a dialog box 
of “Opening File” as showed in figure 3.2.2; then users can select the 
folder where the files to be added in the Look in; furthermore users 
can select the file type from the box of Files of type and input the 
name of a file in the “File name” box or select one or more files to be 
added from the file list box; finally after clicking Open button , users 
can make a choice in “ Do you really want to add the selected files to 
the project?”. Clicking Yes button, the files will be added into the 
project; Clicking No button, all the files under the same folder will be 
added into the project; clicking the Cancel button, not added. 
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Figure 3.2.1 Project Information Dialog Box 

 
Figure 3.2.2 Adding Files Dialog Box  

After the creation of new project, the automatic open of the first 
pile file in the project files will make the corresponding data or 
information displayed in all the areas showed in Figure 3.1.1.  

Before the creation of a new project file, if the previously-opened 
file has already been changed, the system will give the warning of 
whether save it or not. Choosing Yes button, the modification will be 
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saved; choosing No button, not saved. 
2. Open Project 

After opening a project (extension ZPJ), the automatic open of 
the first pile file in the project files will make the corresponding data 
or information displayed in all the areas showed in Figure 3.1.1. 

After selecting the Open Project menu, the dialog box of “Open 
File” will appear. By selecting the folder where the project file to be 
opened in Look in; selecting the file type from the Files of type box ; 
inputting the name in the “File name” box or choosing the files to be 
opened from the list and clicking Open button, the file can be opened. 

 
Figure 3.2.3 Open Project File Dialog Box 

Before opening a new project file, if the previously-opened file 
has already been changed, the system will give the warning of whether 
save it or not. Choosing Yes button, the modification will be saved; 
choosing No button, not saved. 
3. Save Project 

To save the current project data, if it is newly created, the 
function of this menu will be the same as Save Project As menu. If the 
file is not modified, this menu is invalid. Once the file is modified, the 
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menu will be valid. 
4. Save Project As 

To save the currently opened project file as a new project file, 
users shall do the following steps: selecting Save Project As menu and 
selecting the folder where the files to be saved at in the pop-up “Save 
As” dialog box shown in Figure 3.2.4; entering the file name in the 
File name box. To save the file, press the Save button; to not save, the 
Cancel button. 

 
Figure 3.2.4 Save Project As Dialog Box 

Before saving the file, if there is a file with the same name, this 
soft will give users a warning of whether to overwrite the file. 
Choosing Yes button, the former file be overwritten and lost, not 
being restored; choosing No button, the file is not saved and return to 
the dialog box shown in Figure 3.2.4, reentering the file name. 

If the path (folder) of saved as project file has changed, all the 
pile documents it contains will be copied to the new folder. 
5. Close Project 

To close the currently opened project file and return it to the 
original operating status of the program, users must check whether the 
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current project files and pile documents are saved or not. If not saved, 
users are prompted to “Save or Not”. To save, click Yes button; to not 
save, click No button. 
6. Add Files 

This menu is used to add files of other piles to the current project 
file, in order to carry out unified management. 

After choosing Add Files menu, there will pop-up the “Open 
File” dialog box shown in Figure 3.2.6. Users, from the Look in, can 
select the folder which they want to add files, select the file type in the 
Files of type box, enter the file name in the “File name” box or select 
the file to be added from the file list box. Then users will be asked 
“Whether add the selected file to the project or not” by pressing the 
Open button. To add the selected files to the project, press Yes button; 
To add all the files under the folder to the project, press No button; to 
not add, press Cancel button.  

This menu is valid only when the focus is in the Pile List Area. If 
the pile files to be added is not at the same file folder of the current 
project file, the pile file to be added shall be copied to the folder 
where the current project file is in. 
7. Remove Files 

After selecting one or more pile files in the Pile List Area and 
choosing the Remove Files menu, there will pop-up a dialog box 
shown in Figure 3.2.5, after selecting to Remove files or Delete files, 
press OK button to remove or delete the selected files; to not remove 
or delete, press Cancel button. 
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Figure 3.2.5 Delete/Remove file Dialog Box 

The menu is valid only when the focus is in the Pile List Area. 
NOTE: Removing the files will only remove the selected 

pile files from the project file and will not delete them. Deleting 
the files will remove the selected pile files from the project file 
and delete them completely. At least one pile file shall be kept in 
the project files. 
8. Validity Modification 

After selecting one or more pile files from the pile list area, users 
can modify the validity of the selected pile files by choosing the 
Validity Modification menu. 

NOTE: The printout and generation of bitmap and 
summary sheet is only available for the valid pile files in the 
current project. 
9. Open Files 

Open the data file of the single pile (extension ZIT) to analyze 
and process it. After opening the pile file, various areas in the 
interface in Figure 3.1.1 (except Pile List Area) will display the 
corresponding data or information. 

After selecting Open File menu, users can see a pop-up “Open 
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File” dialog box shown in Figure 3.2.6. Users can open the file by 
doing the following: selecting the folder in the Look in where the files 
to be opened located in; selecting the file type to be opened in the 
Files of type box, entering file names in the “File name” box or 
selecting files from the file list box; pressing the Open button. 

 
Figure 3.2.6 Open Files Dialog Box  

Before opening the new file, if the previously-opened file has 
been modified, users will see the warning of save or not. To save the 
modification, press Yes button; to not save, press No button. 
10. Save Files 

To save the current pile files, if it is newly created, its function 
will be the same as “Save Project As” menu. If the file is not modified, 
this menu is invalid. Once the file is modified, the menu will be valid. 
11. Save File As 

To save the currently opened pile file as a new pile file, users 
shall follow the following steps: selecting Save File As menu and 
selecting the folder where the files to be saved at in the pop-up “Save 
As” dialog box shown in Figure 3.2.7; entering the file name in the 
File name box. To save the file, press the Save button; to not save, 
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press the Cancel button. 

 
Figure 3.2.7 Save File As Dialog Box 

Before saving the file, if there is a file with the same name, this 
soft will give users a warning of whether to overwrite the file. 
Choosing Yes button, the former file be overwritten and lost, not 
being restored; choosing No button, the file is not saved and return to 
the dialog box shown in Figure 3.2.7, reentering the file name. 
12. Exporting Text Files 

After saving the related information of pile file and waveform 
data after analysis, users can open them by software like Notepad. 

 
Figure 3.2.8 Exporting Text Files Dialog box  
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Figure 3.2.9 Folder Selection Dialog Box 

After selecting Export Text Files menu, users will see a pop-up 
dialog box of “Exporting Text Files” shown in Figure 3.2.8, from 
which users can select the range of exporting text files. Pressing the 
Cancel button, not export; pressing the OK button, the Folder 
Selection dialog box will pop up (Figure 3.2.9). By selecting the 
targeted folder for the saving of text file and pressing the OK button, 
users can establish a subfolder named after the Project Name under 
the chosen folder (if the Project Name is empty, the subfolder will be 
named project). In such a way, all the generated text files will be kept 
in the subfolder with file name in accordance with the pile file name. 

NOTE: When exporting the text files, users can only 
export pile information and the original data of that waveform 
after pile form analysis. 
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13. Generate Bitmaps 
After selecting Generate Bitmaps, Folder Selection dialog box 

will pop up (Figure 3.2.9). By selecting the targeted folder for the 
saving of bitmap and pressing the OK button, users can establish a 
subfolder named after the Project Name under the chosen folder (if the 
Project Name is empty, the subfolder will be named project). In such a 
way, all the generated bitmaps will be kept in the subfolder with the 
default name of “pile file name-waveform sequence. bmp”. 

After generating a bitmap, a dialog box will pop up of “whether 
insert this bitmap into the word or not”. Pressing the Yes button, users 
will establish a new Word file and insert all the bitmap into it. 

NOTE: When generate a bitmap, users shall output in 
accordance with the “print range and content” “header 
information”, etc in the “print setup”. 
14. Print 

 
Figure 3.2.10 Print Dialog Box 
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After selecting Print, users will see a pop-up dialog box shown in 
Figure 3.2.10. Choosing the printer, page scope and print copies, users 
can print according to the parameter in the “Print Setup” by pressing 
the Print button; pressing the Cancel button, print operation not being 
executed. 
15. Print Preview 

After selecting Print Preview, users will see a print preview page 
and check the effect. 

 
Figure 3.2.11 Print Preview Toolbar 

Figure 3.2.11 is the toolbar of the preview interface. The 
following is the function of the toolbar: Print button is for the print 
output, whose function is same as print of the main menu; Next Page 
button is for paging down and the current page means the last page 
when the button is grayed out (invalid); Prev Page button is for paging 
up and the current page means the first page when the button is grayed 
out (invalid); Two Page/ One Page is for displaying two pages or one 
page side by side at the same time; Zoom In and Zoom Out buttons 
are for magnifying and narrowing display. When the button is in a 
gray state it means it can’t be magnified or narrowed; also by clicking 
the left mouse button on preview interface, functions like magnifying 
and narrowing will be performed; Close button is used for quitting the 
interface of print preview and returning to the main interface. 
16. Print Setup 

Before printing, users can do some print setup. After selecting the 
Print Setup menu, users will see the pop-up “Print Setup” dialog box 
in Figure 3.2.12. There are three pages in the dialog box, namely, 
General, Header and Footer, and Header Information, which are 
showed from Figure (a) to Figure (c). By clicking the left mouse on 
the label, uses can change the page to the corresponding one and go on 
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different print setup on each page. 
In General page, users can set up page margins, print format, 

print range and content and paper type, etc.  

 
(a) General Page 
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(b) Header and Footer Page 
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(c) Header Information Page 

Figure 3.2.12 Print Setup Dialog Box 
In Header and Footer page, users can choose whether Print Page 

Number or not(when decide to print the page number, users can set up 
the position, format and the starting page number)，whether Print 
Header or not (when decide to print the header, users can set up the 
position of header, height and content ), whether Print Footer or not 
(when decide to print footer, users can set up the position of footer, 
height and content) and the Font of Header and Footer, etc. 
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In the “Header Information” page, the list box of Pintable Header 
lists all the printable header information and the list box of To Be 
Printed Header lists all the selected header information to be printed. 
By selecting one or more items in the list box of Pintable Header and 
pressing the Add button, users can transfer all the selected ones to the 
list box of Header To Be Printed; by selecting one or more items in 
the list box of Header To Be Printed and pressing the Remove button, 
users can remove the selected ones from the list box of Header To Be 
Printed. Also after selecting a certain item in the list box of Header To 
Be Printed, users can adjust the sequence of header information in the 
printout by pressing the Move Up button and Move Down button. By 
pressing the Add All button, users can transfer all the printable header 
information to the list box of Header To Be Printed. By pressing the 
Remove button, users can remove all the header information from the 
list box of Header To Be Printed. Besides, users can input the Header 
Title and Header Content in the box of “Other header information” 
below, maximum number of 6. Also, users can select information like 
header font, table row height and text alignment, etc. 

By pressing Default button at any page, users can set up all the 
parameter at every page as the default value. 

NOTE: This software is mainly available for the paper 
specification of A4 and B5. When choosing other paper 
specification, users may meet some troubles. For the best effect, 
please use A4 specification. 
17. Print to Bitmaps 

When choose Print to Bitmaps, users can obtain bitmaps 
generated from the printout, each page being a bitmap. Those bitmaps 
are at the same folder of data files with file name of “Project name-P 
page.bmp”. Once the bitmap is generated, there will emerge a box 
asking “whether insert the bitmap into Word or not”. By pressing Yes 
button, users can establish a new Word and insert all the bitmaps into 
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it. 
18. Recent Project Files 
     On the pop-up menu of this menu, there are four recent project 
files opened by users. Thus, users can open one of them by clicking 
one of them directly. Also, users can clear the list of file name on the 
menu just by clicking the following menu items Recent Project Files 
→ Clear record.  
19. Recent Pile Files 

On the pop-up menu of this menu, there are four recent pile files 
opened by users. Thus, users can open one of them by clicking one of 
them directly. Also, users can clear the list of file name on the menu 
just by clicking the following menu items Recent Pile Files → Clear 
record. 
20. Exit 
   By closing the current project file and data file, users can log out 
the system. Before closing the files, users will see a prompt for saving 
files if the project file or the current pile file has been modified. 
 

3.2.2 Edit Menu  

For the convenience of users to examine detected waveforms, 
this menu is mainly for  zooming in and zooming out of waveform 
vertically; expanding and compressing of waveform horizontally.  
1. Pile Head Alignment 
    After selecting the menu item of Align Pile Head, users can align 
the pile head of all channels waveform in the current pile file with the 
backmost pile head of all channels waveform in this file. 
2. Waveform Reversing 
    By selecting the menu of Reverse, users can reverse all channels 
waveform in current pile file. 
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3. Waveform Stretching  
When the current focus is at the Waveform Area, by selecting the 

menu item of Stretch, users can display all channel waveforms in 
current pile file by stretching them horizontally (axis of time or 
length). Beyond a certain extent, this menu becomes invalid. If the 
current focus is not at the Waveform Area, this menu is invalid as 
well. 
4. Waveform Compressing 
When the current focus is at the Waveform Area, by selecting the 
menu item of Compress, users can display all channel waveforms in 
current pile file by compressing them horizontally (axis of time or 
length). Beyond a certain extent, this menu becomes invalid. If the 
current focus is not at the Waveform Area, this menu is invalid as 
well. 

NOTE: The stretching and compressing of waveform can 
also be implemented by dragging the slider of “tensile 
compressive ratio” in the Pile Information Area. 
5. Waveform Zooming  

After selecting a row of waveform in the Waveform Area and 
choosing the menu of Zoom, users can zoom in or zoom out the 
waveform by dragging the left mouse button up and down, Besides, 
the ＋ and － buttons also can perform this function.  

NOTE: When selecting “Normalization Display” in 
“Setting  Options”, users will find it not available, for this menu 
is grayed out. 
6. Waveform Overlapping 

After selecting the menu of Overlap, people will see a pop-up 
dialog box shown in Figure 3.2.13. By selecting more than two 
waveforms, users can make a overlapping of the selected ones by 
pressing OK button with the waveform after overlapping being added 
to the final place of this file. By pressing Cancel button, there will be 
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no overlapping. 

 
Figure 3.2.13 Waveform Overlapping Dialog Box 

7. Waveform Deletion 
By selecting the Delete Waveform menu, users can delete the 

current waveform in the current pile file. This menu is available only 
when the current focus is at the Waveform Area. 

NOTE: Be cautious, for the deleted waveform can not 
be restored! 

 

3.2.3 View Menu 

1. Sampling Parameter 
By selecting the Sampling Parameter item, users will see a 

pop-up dialogue shown in Figure 3.2.17, which can display the 
sampling parameter information of the current pile file and modify 
sensor type as well as sensitivity. 
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Figure 3.2.17 Sampling Parameter Dialog box 

1) Sampling Length is the points when taking sample of the 
signal. 

2) Sampling Interval is the time difference between every two 
sampling of the signal and the range of it is 5μs∼64ms. 

3) Gain is the amplification factor of the instruments to the 
electric signal received by transducer, that is, fixed point 
amplification.  

4) Trigger Level is the signal level when starting the instrument 
to take sample and it has three gears of high, middle and low.  

5) Sampling Method has two modes: single collection and 
continuous collection. Single Collection means users can only collect 
the waveform once every time according to the setting of parameters; 
and Continuous Collection means that several continuous samplings 
process in the same parameter setting until users stop it. 

6) Channel Selection: Dynamic measuring devices have two 
receiving channels. Users can use either Channel 1 or Channel 2 to 
collect when testing or use them simultaneously. Choose the channel 
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to which the sensor is connected, or users can not collect signals. If 
users choose Dual Channel 1, it means double channel sampling and 
the trigger channel is channel 1; if users choose Dual Channel 2, it 
means double sampling and the trigger channel is channel 2. 

7)  Acceptance Mode: In the field detection, the stand or fall of 
knocking will affect the quality of the collected signals. Knocking 
with too much force makes the signals distort while with too little 
force, pile toe signal may not come out, so the force must be moderate. 
Users can judge the size of force according to the strength of the 
signals. 

Acceptance Mode consists of three types: Manual, Automatic or 
None.  

8) Analog filtering means to conduct low-pass filtering to the 
original signal on the hardware.  

9) Sensor Type: Dynamic measuring devices can be allocated to 
ICP acceleration, speed, the common acceleration (output charge) 
sensor for testing, so users should select this option according to the 
types of transducer.  

10) System Sensitivity Setting: The value of the system 
sensitivity is demarcated by metrological service, always set when 
leaving factory and users needn’t modify. After setting the type of the 
transducer, the instrument will set the system sensitivity as factory 
default automatically. Users need to modify it only when the system is 
demarcated again and the sensitivity changes or users use transducers 
that are not from our company.  

The unit of the value of the system sensitivity of the ICP is 
2/ −⋅ smmV , and the velocity sensor is 1/ −⋅ scmmV , and the 

acceleration transducer is 2/ −⋅ smpC . 

Users can collect with dynamic measuring devices by double 
channels simultaneously, so there are two values of the system 
sensitivity (sensitivity 1, sensitivity 2) need to be set. 
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11) Triggering Mode contain Signal Trigger and External Trigger 
and users should use signal trigger when testing piles. External trigger 
is only used during verification when leaving factory to verify system 
noise and dynamic range and other index, and it can also be used on 
other testing occasions.  

12) Delay Points: Generally, this parameter needn’t be modified, 
users can just use the default value (-100). Delay points should 
between -512~512, negative means negative delay (Trigger in 
advance), zero means zero delay (Trigger at once), positive means 
delay trigger.  
2. Pile Information Area 

By selecting the item of Pile Info. Area, users can display or hide 
the Pile Information Area in the main page. To display, put a “√” 
before the menu; otherwise, it will be hidden. 
3. Statistical Information 

By selecting the item of Statistical Info., users will see a pop-up 
dialog box shown in Figure 3.2.18, which shows all the pile statistical 
information of the current project file. 

 
Figure 3.2.18 Statistical Information Dialog Box 

 
4. Tool Bar 

This menu is mainly for hiding or displaying tool bar. System 
default is displaying tool bar. (The menu item is displayed if there is a 
“√” in front of menu bar; otherwise it will not be displayed.) 
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5. Status Bar 
This menu is mainly for hiding or displaying status bar. System 

default is displaying status bar. (The menu item is displayed if there is 
a “√” in front of menu bar; otherwise it will not be displayed.) 

 

3.2.4 Setting Menu 

1. Options 

 

Figure 3.2.19 Options Setting Dialog Box. 
When users select the Options menu item, the dialog box as 

Figure 3.2.19 shows pops up. In the dialog box, values of all 
parameters default to the ones which are set most recently. Users can 
select Horizontal Axis (time or length, which can change the units and 
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scale values in the horizontal axis of each waveform), Filling Pattern 
(non-filling, positive filling or negative filling, non-filling in all 
waveforms, fill in positive or negative half cycle), Waveform 
Direction (forward or reverse, which can change the display direction 
of all waveforms), Scope of Applications (current channel or all 
channels), Automatic Identification, Normalized Display. If users have 
set all parameters, press OK and the setting is valid or press Cancel 
and invalid. 

If users select “Automatic Identification”, the system will 
automatically find the pile head position (crest or trough of direct 
wave) in analyzing and processing and automatically find the peak 
frequency in the spectrum analysis. If users want to set the pile head 
position manually, users should never select the option (to remove 
“√”). 

The “Normalized Display” means that regardless of the 
maximum amplitude of the waveform, the system will maximize its 
display on the condition that each waveform display is full of the 
waveform area. If users don’t select the option, users may not see 
when sometimes the waveform amplitude is small and need to 
manually scale the waveform. The “Waveform Height” refers to the 
height which the single-channel waveform in the waveform district 
displays (unit: pixel); the “X Grid” means to draw vertical grid line 
when to display waveform; the “Y Grid” means to draw horizontal 
grid line. 
2. Project Information 

When users select the Project Info. menu item, the dialog box as 
Figure 3.2.20 shows pops up. Users can set a series of related 
information like Project Name, Construction Unit, Detection Unit, 
Qualification No., Report No. and so on. If users have finished the 
setting, press OK and the input information is valid; press Cancel and 
invalid. If users press Default, all parameters in the dialog box are the 
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most recently set values; press Read, the dialog box of “Open Project 
File” pops up. Then, users can select a project file in the dialog box 
and press OK, the project information of the selected project file is 
read; if users press Cancel, its project information is not read. 

 
Figure 3.2.20 Project Information Setting Dialog Box 

 
Figure 3.2.21 Date Selecting Input 

Click  behind the column of Starting Date in the dialog box 
and the date input interface as Figure 3.2.21 shows pops up. The input 
method is as follows: 1) click the Year (2005) position in the interface 

with the left mouse button,  appears and the year can be 
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adjusted by pressing  and ; 2) click  and  of the left side and 
right side at the top of the interface and users can adjust the month. 
Users can also click Month (May) position and select the month in the 
pop-up list; 3) click date figures and users can adjust the date. Click 
on other positions rather than date input interface and the interface 
disappears, with the date updated. 

NOTE: In other dialog boxes or interfaces, the above 
interface will pop up in all positions where the date is input. 
Besides, the input method is alike. 
3. Pile Head 

When the waveform area shows the oscillograph, select a 
waveform in the area and move the cursor to the location where the 
pile head is to be set. If users select the Pile Head menu item, the 
position of the current cursor is set to the position of the pile head. 

If users want to set the pile head manually, users must remove the 
“Automatic Identification” option from the Options menu, or the 
system will find the position of the pile head automatically in 
analyzing and processing and thus the manual setting does not work. 

NOTE: The pile head cursor must locate within the 
waveform area. Besides, the pile head can not locate behind the 
pile toe. 
4. Pile Toe 

 
Figure 3.2.22 Pile Toe Setting Dialog Box. 
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When the waveform area shows the waveform figures, select a 
waveform in the area and move the cursor to the position where the 
pile toe id going to be set. If users select the Pile Toe menu item, the 
dialog box as Figure 3.2.22 shows pops up and users can choose the 
type of the pile head. Press OK and the setting is valid; press Cancel 
and invalid. 

NOTE: The pile toe cursor must locate with the 
waveform area. Besides, the pile toe can not locate before the 
pile head. 
5. Defects 

When the waveform area shows the waveform figures, select a 
waveform in the area and move the cursor to the defect location. If 
users select the Defects menu item, the dialog box as Figure 3.2.23 
shows pops up and users can choose the Defects Type and its Severity. 
Press OK and the setting is valid; press Cancel and the setting is 
invalid. 

 
Figure 3.2.23 Defects Setting Dialog Box. 

NOTE: The defect location must be between the pile 
head and the pile toe. If the gap of the defect location between 
two consecutive settings is less than 0.1 m and their types and 
severities are identical, the defect is canceled. If the gap is less 
than 0.1 m and their types and severities are different, the defect 
setting in this location is updated. 
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6. Peak Frequency 
When the waveform area shows the spectrum, select a spectrum 

in the spectrum area and move the cursor to the location where the 
peak is to be set. Select the Peak Freq. menu item and set the 
frequency of the current cursor location to a peak frequency. After that, 
the information related to the peak frequency will display in the right 
side of the spectrum. As Figure 3.2.24 shows, Fm is the main 
frequency value, F0 is the frequency resolution, and F1 to F5 are the 
set frequency peaks. At most 5 frequency peaks can be set. 

 
Figure 3.2.24 Peak Frequency 

 
If users want to set the peak frequency manually, users must 

remove the “Automatic Identification” option from the Options menu 
item, or the manual setting does not work. 

If the set peak frequencies in two times are equal, the peak 
frequency is canceled. 
7. Clear 

If the waveform area shows the time domain waveform figure, 
select the Clear menu item and all defect settings are removed. If the 
waveform area shows the amplitude spectrum or power spectrum, 
select the Clear menu item and all the peak frequency settings are 
removed. 
8. Print Mark 

If users have selected a waveform in the waveform area, select 
the Set Print Mark menu item and a red “√” will appear in the upper 
right corner of the waveform. If users want to remove the print mark, 
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after users have selected the waveform, select the Remove Print Mark 
menu item and the “√” in the upper right corner will disappear. 

 

3.2.5 Processing Menu 

There often exist some “Clutters” (noise signals) in the waveform 
data collected at the scene or the signals in the pile toe are weak. In 
that case, in order to highlight useful signals, digital signal processing 
methods must be used to process it. In the analysis software, several 
processing approaches are referred: 
1) Integration: When using the accelerometer to detect, the collected 

signal is the acceleration signal. It seems that it is relatively 
“messy” and often has a general need for the integration 
processing to turn it into a speed signal. In that way, it will look 
relatively clear. The integration can’t apply to the speed signal. In 
the bottom of the pile-shaped area, “Vel” and “Acc” appears to 
respectively show the signal of speed and acceleration. 

2) Signal Amplification: When the signal in the pile toe is weak, 
there is a general need for the waveform to take amplification 
processing to highlight the signal in the pile toe. If users want to 
take digital amplification to the collected signal, users should set 
the amplification type (exponential, linear, or full scale), the 
amplification starting point and the amplification factor. 
Exponential or linear amplification is to amplify the signal from 
the starting point to the pile toe according to the exponential or 
linear mode; the full factor amplification is to take linear or 
exponential amplification on the purpose of identical signal 
amplitude in the pile toe and amplitude in the first wave. The 
amplification starting point is the starting position taking 
exponential or linear amplification (relative to the pile head, unit: 
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m). the scope of amplification starting point is from 0m to 0.8 
times the length of the pile. Multiples of the exponential or linear 
amplification should not be too large, as long as the signal in the 
pile toe can be saw. 

3) Wavelet Analysis: The wavelet analysis is a new time-frequency 
analysis mode developed in recent years. It is a great 
breakthrough in signal processing, image compression, speech 
coding, pattern recognition, seismic exploration and many other 
non-linear scientific fields, which has been widely applied. If 
users apply it to the analysis of dynamic test signal, users can get 
a better effect. The wavelet factor needs setting (range of 1~8). 
The greater the factor is, the more “gentle” the signal is. 
Generally speaking, the wavelet factor is set to any number 
between 1~3 because too large number can result in miscarriage 
with defect signals removed. 

4) Digital Filtering: It is made up of three filtering approaches, 
low-pass, high-pass and band-pass. The low-pass filtering is to 
filter the signal which is larger than a certain cut-off frequency. 
The high-pass filtering, however, is to filter the signal which is 
smaller than a certain cut-off frequency. The band-pass filtering 
is to filter the signal which is larger than the high cut-off 
frequency and smaller than the low cut-off frequency. Figure 
3.2.25 is a sketch map of filtering. In analysis, the low-pass 
filtering is frequently used. The value of cut-off frequency can be 
set from experience. The longer the pile is, the lower the 
low-pass cut-off frequency. The setting of the value of cut-off 
frequency can be also based on the spectrum analysis of signals. 

 
Figure 3.2.25 Filtering Sketch Map 
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5) Smoothing: When high-frequency “Clutters” appear in the signal, 
smoothing can be used to filter them. The larger the smoothing 
point is, the more “gentle” the smoothed waveform. The range of 
the smoothing point is from 3~512, generally set to 10. 

6) Waveform Rotation: Sometimes, when having taken integral 
processing or any other processing to the signal, the end of the 
waveform may upwarp. In that case, waveform needs rotation to 
pull the end part into the position of baseline. The percentage of 
rotation is relative to the direct wave amplitude. The positive 
number means the rotation forward and the negative number 
means the rotation inverse. If the first wave amplitude is A and 
the amplitude in the end of the signal is B, the percentage of 
rotation is (100×B/A). 
In the above-mentioned processing modes, the wavelet analysis, 

digital filtering and smoothing can all filter. So users can just choose 
one method from them and users can also use them simultaneously. 
The employed parameters should be appropriate, or miscarriage may 
happen with some useful signals removed. 

All processing parameters can modify in the Pile Information 
Area (Figure 3.1.3). If users have finished the modification, users can 
process all waveforms in the current pile according to the set 
parameters by pressing . For some parameters, users can also click 

 with the left mouse button to make modification.  
1. Batch 

When users select the Batch menu item, the dialog box as Figure 
3.2.26 shows pops up and users can choose the parameters which will 
apply to all piles in the current project. Press OK and the setting is 
valid; press Cancel and the setting is invalid. 
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Figure 3.2.26 Batch processing dialog box 

2. Integration 
  When users select the Integrate menu item, the waveform is 
integrated. To select the menu item again and the operation is 
cancelled. The shortcut key for the function is F4. 
3. Amplification Increase 

When users select the Amplification Increase menu item, the 
amplification factor increase 1 on the basis of the current level and 
directly process the waveform. The shortcut key for the function is 
F5. 
4. Amplification Decrease 

When users choose the Amplification Decrease menu item, the 
amplification factor decrease 1 on the basis of the current level and 
directly process the waveform. The shortcut key for the function is 
F6. 
5. Wavelet Increase 

When users select the Wavelet Increase menu item, the wavelet 
factor increase 0.5 on the basis of the current level and directly 
process the waveform. The shortcut key for the function is F7. 
6. Wavelet Decrease 

When users select the Wavelet Decrease menu item, the wavelet 
factor decrease 0.5 on the basis of the current level and directly 
process the waveform. The shortcut key for the function is F8. 
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7. Rotate Forward 
  When users select the Rotate Forward menu item, the percentage of 
waveform rotation increase 5 on the basis of the current level and 
directly process the waveform. The shortcut key for the function is 
F9. 
8. Rotate Reverse 
  When users select the Rotate Reverse menu item, the percentage of 
waveform rotation decrease 5 on the basis of the current level and 
directly process the waveform. The shortcut key for the function is 
F10. 
9. Parameter Recovery 
  When users select the Parameter Recovery menu item, the 
processing parameter of the current pile is recovered to the default 
value. It means that without any processing, the waveform is 
recovered to the original waveform. The shortcut key for the 
function are Ctrl +Shift+ Z. 
10. Amplitude Spectrum 

When users select the Amplitude Spectrum menu item, all 
waveforms of the current pile are analyzed by amplitude spectrum. 
The amplitude spectrum is shown in the waveform area as Figure 
3.1.6 shows. If the present view is amplitude spectrum, tick 
“√”before the menu item. If users want to show time domain 
waveform, select this menu item again and just remove “√”. 
11. Auto-power Spectrum 

When users select the Auto-Power Spectrum menu item, all 
waveforms of the current pile will be analyzed by auto-power 
spectrum. The auto-power spectrum is shown in waveform area, as 
Figure 3.1.6 shows. If the present view is auto-power spectrum, tick 
“√” before this menu item. If users want to show time domain wave, 
then select this menu item again and just remove “√”. 
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3.2.7 Help Menu 

1. About 
Display our company’s name, software name and version number 

or any other information. 
2. Visit the Company’s Website 

For more and better understanding of our company, please select 
Visit ZBL to link to our company’s home page 
3. Write to Our Company 

In order to feedback to us timely, users can select Email to call 
the Out Look to send email to our company. 
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Appendix 1 Common Shortcut Keys 

In the software, users can use the shortcut keys (keys listed behind the 
menu item) to operate some common functions to improve the 
working efficiency. They are listed as follows: 
 

1. Shortcut Keys in File Menu 
  Function  Keys Function Keys 
New Project Ctrl+N Open File Alt+O 
Open Project Ctrl+O Save File Alt +S 
Save Project Ctrl+S Generate Bitmaps Ctrl+B 
Remove Files Shift+Del Print Ctrl+P 

Validity Modification Space Print Preview Ctrl+V 

 
2. Shortcut Keys in Edit and View Menu 

Function Keys Function Keys 
Reverse Ctrl+W Delete Waveform Ctrl+Del 
Stretch Ctrl+＋ Page Turn PageUp、PageDn

Compress Ctrl+- Channel Switch ↑、↓ 

 

3. Shortcut Keys in Setting Menu 
Function Keys Function Keys 
Pile Head Ctrl+T Peak Frequency Ctrl+Q 
Pile Toe Ctrl+D Clear Ctrl+L 
Defects Ctrl+F   
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4. Shortcut Keys in Processing Menu 
Function Keys Function Keys 

Amplification Increase F5 Rotate Forward F9 
Amplification Decrease F6 Rotate Reverse F10 

Wavelet Increase F7 Amplitude Spectrum F2 
Wavelet Decrease F8 Auto-Power Spectrum F3 

Parameter Recovery Ctrl+Shift+Z Integrate F4 
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